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Introduction
Scepter Software Pro is a data analysis companion to the Scepter Handheld Cell Counter. It is used 
to connect with one or more Scepter devices, upload test files, and archive analyzed data on your 
computer disc. The software module promotes efficient interrogation of test files on a sample-by-
sample basis or as multi-file overlays using the Current Acquisition Plot and Multifunction Plot, 
respectively. Overlays are well suited for applications such as general cell culture QC, analysis of 
divergent populations in co-cultures, and viability experiments. Histogram plots are equipped with 
adjustable marker(s) and scalable Y-axes, permitting greater accuracy and interrogative power. Each 
plot has a corresponding table in the Group Stats window that instantly compiles results for any 
changes to the plot content. The table data can be easily customized and exported. The analytical tools 
available through Scepter Software Pro make the Scepter system ideal for laboratories that need a 
highly flexible system capable of fast feedback on experiments as well as sophisticated analysis and 
reporting.

This user guide provides information on the following:

■■ Installation of Scepter Software Pro

■■ Steps to conduct a basic analysis session

■■ Examples of comparative data for various applications

■■ A list of resources for help in achieving optimal system performance

■■ A glossary of terms associated with the software application

Operating System Compatibility and Requirements
The following tables show which Windows and Macintosh® operating systems are compatible with the 
Scepter software, and the minimum system requirements to run the program.

Operating System Compatibility
Operating System Version

Windows XP® SP3 32-bit
Windows Vista® SP1 32-bit
Windows 7 RTM 32-bit
Mac OS® X 10.5 and 10.6

System Requirements
Random Access Memory (RAM) 1 GB or more
Hard Disc – Applications and Drivers 20 MB
Hard Disc – Uploaded Data File ~5 KB per file
Universal Serial Port (USB) 2.0
Minimum Display Resolution 1280 x 768 (VGA)

You need an Internet connection to download and install the Scepter Software Pro module. Registered 
users receive e-mail alerts regarding updates to software and new Scepter applications.
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Software Installation/Removal
For Windows Operating Systems
To install Scepter Software Pro

1.	 Save the Scepter zip file to your computer.

2.	 Once saved, right click on the folder and select Extract All…

3.	 Double click on the Setup.msi file and follow the instructions in the Setup Wizard. Once 
installation is complete, a shortcut to the Scepter Software Pro appears on your desktop.

Figure 1.  Shortcut to Scepter Software Application

To uninstall Scepter Software Pro
Close the Scepter program and disconnect the Scepter device before you start the process. In the 
Control Panel of your operating system, click on the Add or Remove Programs icon, if you are 
using the Windows XP operating system, or the Programs and Features icon, if using Windows 
Vista or Windows 7 operating systems. Then, select Scepter from the list of programs.

The uninstall process removes the Scepter PC software, desktop shortcut, start menu link, and USB 
driver files but does not remove any of the data files uploaded from connected devices. The applica-
tion can be re-installed using the installation process described above.

For Mac OS X Operating Systems
To install Scepter Software Pro

1.	 Save the Scepter zip file to your computer. It automatically expands and mounts to your 
desktop after you download it, opening the installation window (Figure 2). If it does not 
expand, double click on the zip file to expand it.

Figure 2.  Scepter software installation on a Macintosh computer
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2.	 Drag the Scepter application icon onto the Applications icon to copy the 
application to your computer’s Applications folder. Alternatively, drag the icon to any other 
folder on your hard drive to complete the installation.

To uninstall Scepter Software Pro
Drag the Scepter application to the trash.

The Basic Work Flow
Scepter Software Pro simplifies the upload and management of test files acquired by the Scepter 
device. It provides both singular and comparative analysis of test files, as well as the formatting of 
printable reports. This section of the user guide provides an overview of the five main areas of the user 
interface and the basic steps to conduct an analysis session. The basic steps are illustrated using seven 
test files from a co-culture experiment where samples differ by relative percentages of two cell types.

For Mac OS X Operating Systems, continued
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Overview of the User Interface

Figure 3.  The five main components of the user interface

1 Data Panel Displays all data sets used during an analysis session and provides 
access to previously saved data as well as files directly uploaded 
from a connected Scepter device. 

2 Analysis Template Houses a set of user-defined histogram overlay marker(s) to 
analyze one or more test files in the Multifunction Plot, providing 
an effective way of standardizing analysis parameters across 
multiple data sets.

3 Current Acquisition Plot Displays data from any test file highlighted in the Data panel. 
The plot can display data in either diameter or volume modes 
(X-axis) and at scalable cell counts (Y-axis). A maximum of eight 
adjustable histogram markers can be applied to the plot.

4 Multifunction Plot Uses overlays to simultaneously display and analyze data from 
multiple test files with newly defined markers. A setup feature 
allows customizing of histogram color and other visual properties. 
A maximum of eight adjustable histogram markers can be applied 
to the plot.

5 Group Stats Displays statistics and conditions associated with test run(s) in 
either the Current Acquisition Plot or the Multifunction Plot. The 
Setup feature and Notes/Comments field are used to customize 
reports. Results can be exported for further analysis or printed as 
concise reports.
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Connecting to the Scepter Device and Uploading Test Files
Scepter Software Pro can connect to multiple Scepter devices simultaneously. Test files can be up-
loaded at the time of connection or analyzed directly without uploading. However, any changes to 
files that have not been saved on the computer disc are lost if the Scepter device is disconnected. 
All original files remain on the Scepter device; neither connecting nor disconnecting has an effect 
on these files.

To connect the Scepter device and upload test files

1.	 Turn on the Scepter device and attach it to the computer using the USB cable provided.

2.	 Click the Scepter application shortcut on your desktop. After the program launches, the 
Scepter Software Pro connection dialog box appears (Figure 4).

NOTE: You can launch the software before or after connecting the hardware.

Figure 4.  The Scepter Software Pro connection dialog box

3.	 Click the Browse button to choose a folder in the directory or to create a new folder. 
The box next to Upload files to the following location is checked by default. You can 
uncheck the box if you do not want to upload files. Files that are not uploaded can still be 
saved following analysis. See Saving Changes and Deleting Test Files.

4.	 Click OK to initiate the connection and to upload test files. If the Scepter device is “asleep” 
or if it is accessing histograms, settings, or help screens, Scepter Software Pro displays an 
error message, and the connection is aborted. Once connected, the name of the device 
(DEVICE-Scepter SN) appears in the Data panel, with the uploaded test files listed below 
the device name. Test 01 is highlighted and its data is displayed in both the Current 
Acquisition and Multifunction Plots. Statistics for the entire data set are shown in the 
Group Stats window, in the Acquisition table (Figure 5).
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Figure 5.  Data from a Scepter device with Test 01 highlighted

NOTE: You can also connect a device and upload files through the Device Panel icon or the 
Tools menu (Figure 6).

Figure 6.  The Device Panel: options for accessing

To connect the Scepter device and upload test files, continued
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To access previously uploaded test files
Click the Open icon below the Data panel or click the File menu and Open. Use the 
Browse Folder dialog to select a folder containing saved test files.

Figure 7.  Options for accessing previously uploaded test files

To remove folders from the Data panel
Click the Remove icon at the bottom of the Data panel. If you have made changes to any test 
files in the data folder, a dialog box appears (Figure 8). If you wish to save unsaved changes, click 
Yes; otherwise, click No.

Figure 8.  Scepter Application unsaved changes dialog box
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NOTES: Removing folders from the Data panel does not delete folders or test files previously 
uploaded to the computer disc.

The Remove icon is also used to permanently delete test files from both data folders 
and the Scepter device. See Saving Changes and Deleting Test Files for more information.

To disconnect the Scepter device from the computer

1.	 Click Disconnect on the Scepter device screen or unplug the device from the USB port of 
the computer. A dialog box appears (Figure 9).

2.	 Click No to disconnect without saving changes. Otherwise, click Yes and select a folder 
from the directory; all test files listed under the Scepter node are saved to the chosen 
location. 

NOTE: Disconnecting a device only affects the test files under Scepter nodes in the Data 
panel, not the test files under data nodes.

Figure 9.  Scepter Application disconnect dialog box

NOTES: Devices connected to the software for the first time have a default name of DEVICE, 
followed by a hyphen, followed by the serial number (SN) of the unit. See Additional 
Operations, Assigning a Name to a Device, for directions on renaming.

While the Scepter system assigns names to test files based on a standard format  
(SN [Combination of 8 Numbers and Letters] Test [NN] - [Mon DD HH:MM:SS]), you can 
rename the test files on your PC after they have been uploaded. The new name is displayed 
in Scepter Software Pro when you open the folder through the application.

The USB cable supplies power from the computer to the device during an analysis session. 
If unattended while connected, the device goes into sleep mode.

To remove folders from the Data panel, continued
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Analyzing Individual Test Files
Scepter Software Pro provides features for both qualitative and quantitative analysis of individual 
test files by the Current Acquisition Plot. Features include the application of one or more histogram 
markers, the choice of two formats to display data (as measurements of cell volume or cell 
diameter), and Y-axis scaling (cell count).

To analyze individual test files
Click any test file in the Data panel or Group Stats table to display data. For newly uploaded files, 
the histogram marker (M1) is positioned as it was originally acquired on the Scepter device.

To change the file displayed
Click a different test file.

To adjust marker position
For vertical adjustments, click and hold on the marker region and then move the bar up or down.

For horizontal adjustments, click and hold on either end of the marker to expand or narrow the 
region. A tooltip window appears and updates the exact position of each boundary in real-time. All 
statistics are immediately re-calculated and displayed in the Group Stats window, in the Acquisition 
table.

To add or remove a marker
Click on the icon to add or remove markers. New markers for each test run are numbered as 
M2, M3, and M4…. Once a marker is adjusted or a new marker is added, the Stats table updates all 
statistics to reflect the changes.

Figure 10.  Adding or removing markers on the histogram plot
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To make changes to the Current Acquisition Plot 
Click the Zoom icon to undock and enlarge the plot, if desired.

Click on the name for the X-axis to toggle between cell diameter and cell volume formats.

Click on the Y-axis to access a menu of pre-determined cell count ranges, or click on 
Custom Count.

Figure 11.  Adjusting the X- and Y-axes of the Current Acquisition Plot

NOTES: The Data panel can be undocked by clicking the icon. This action causes the panels to 
become semi-transparent and enlarges the Group Stats window. The panel can be re-
docked by clicking and holding to drag it to its original position and then releasing the 
mouse. The panel can also be re-docked on the right side of the screen following the same 
procedure.

The Group Stats window can be undocked by clicking on the Zoom icon on the upper 
right corner of the window. The undocked Group Stats window can be resized by left click 
dragging on the lower right corner of the window.

Like the Scepter device, Scepter Software Pro displays high concentration warnings in 
red text above a histogram plot if the concentrations are greater than 1.5e6 and 0.5e6 
particles/mL for the 40 and 60 µm sensors, respectively.
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Saving Changes and Deleting Test Files
Adjustments to the markers in test files are not permanent; edited test files must be saved before 
quitting the application.

To save changes to a single file
Click on the test file to highlight it and then click the Save Data File(s) icon at the base of the 
Data panel. Alternatively, select the File menu and Save As.

Choose a folder from the directory and, if desired, rename the test file. The test file is saved as 
a copy. Saving the edited file in the same folder as the original causes the original file to be 
overwritten. Alternatively, click on the File menu and select Save to directly overwrite a test file.

Figure 12.  Options for saving changes to a single test file

To save changes to multiple test files
Hold down the Ctrl key and click on multiple files to highlight them. Click on the File menu, and 
then click Save. A dialog box appears (Figure 13). Choose Overwrite to overwrite the original files 
or Save as Copy to save the edited files as copies.

Figure 13.  Save Scepter Files dialog box

Alternatively, click the Save Data File(s) icon or click the File menu and then Save As.

Next, select a folder from the directory and choose to overwrite the current files or to save them 
as copies. Saving as copies causes each file to be renamed as “Copy of file_Original Name”. Files 
cannot be renamed when multiple files are saved simultaneously.
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Figure 14.  Options for saving changes to multiple test files

To delete test files under a data node or a Scepter device node
Click on the test file and then click the Remove icon below the Data panel. A dialog box 
appears (Figure 15). Click Continue to delete files; otherwise, click Cancel. The test file is deleted 
from the both Data panel and from its folder on the PC disc.

Figure 15.  Delete Data dialog box

To erase multiple files
Press the Ctrl key and click on the test files to highlight them, then click the Remove icon.

NOTE: If you delete a file in the Data panel under a Scepter device node, the file is permanently 
erased from the Scepter device and the Data panel.

Analyzing Multiple Test files
Multiple test files can be easily compared using the Multifunction (overlay) Plot. Statistics from 
the overlay plot are displayed in Groups Stats in the Overlay table. Like the Current Acquisition 
Plot, the overlay plot has a set of icons for interacting with the plot. See Analyzing Individual Test 
Files, To Make Changes to the Current Acquisition Plot for more detail. In addition, the Analysis 
Template feature provides an effective way of standardizing data analysis parameters across 
multiple data sets. Each Template is comprised of a user-defined set of markers that can be saved 
and re-applied.

To save changes to multiple test files, continued
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Figure 16.  Multifunction plot, with zoom-in on icons

To select files for display in the Multifunction plot
Check the boxes to the left of all the test files in the data panel that you want to include in the 
overlay. Files can also be included by clicking and holding on a file in the data panel, dragging the 
file to the Multifunction Plot, and then releasing the file. To drag multiple files, use Ctrl and click. 

If you want to overlay test files located in different folders or Scepter nodes, first save copies of the 
files to a new folder on your computer and upload that folder into the software.

NOTES: Once selected, the test files lose their markers (M1, M2, and M3). You can create a new set 
of markers to be applied to all the test files in the overlay.

The Scepter software creates a new X-axis scale for a blended overlay (overlays combining 
files for 40 and 60 µm sensor tests).

The new set of markers is independent of the new X-axis scale and therefore does not 
“move”.

Analyzing Multiple Test Files, continued

A.  40 µm test file (X-axis scale 3–18) B.  60 µm test file (X-axis scale 6–36)
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C.  Blended overlay of 40 µm and 60 µm test files (X-axis scale 3–36)

Figure 17.  X-axis scales for individual test files (A and B) versus the X-axis scale for a 
blended overlay (C)

The Analysis Template
When Scepter Software Pro is launched, the Analysis Template panel displays a single template 
named Default Template. Double click on the default to enter a new name. As histogram regions 
are added, each is listed in the Region List under the template name (O1, O2, O3…). The Analysis 
Template can be saved using the Save Template icon and recalled using the Open Template
icon in the Analysis Template panel.

Figure 18.  Analysis Template panel

To add or remove a histogram region

Click on the Show/Hide Histogram Region icon, and then select Add Histogram Region. 
New markers for the Multifunction plot are numbered O1, O2, and O3…. Select the Remove 
Histogram Region to delete the most recent marker from the plot.

To adjust the marker

For vertical adjustments, click and hold on the marker region, then move the bar up or down.

For horizontal adjustments, click on the marker, then click and hold on either end of the region 
to expand or narrow the region.

As soon as a marker is adjusted or a new marker is added or removed, all statistics in the Stats 
table are updated to reflect the changes.

To select files for display in the Multifunction plot, continued
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To save an Analysis Template

Click the Save Template icon at the base on the Analysis Template panel. Select a folder 
from the computer directory and click Save. Analysis templates are saved as .gsy files.

To apply a template to an overlay plot

Click the Open Templates icon at the base of the Analysis Template panel and use the 
directory to locate the appropriate file.

NOTE: Only one Analysis Template can be open at a time. Therefore, opening a saved template 
replaces the template that was previously housed in the panel. Any changes made to the 
previous template are lost if the changes were not saved prior to replacing it.

The Overlay Setup
The appearance of the Multifunction Plot can be customized using the Overlay Setup feature.

To customize the Multifunction Plot using a Windows Operating System

1.	 In the Multifunction Plot panel, click the Overlay Setup List icon. The Overlay Setup 
window appears.

2.	 Uncheck boxes in the Show column to remove any test files from the display. Files can also 
be removed by clicking on the file listing and selecting Delete.

3.	 Click on Line Style, Line Color, and Fill next to the appropriate test files, and use the 
options on the popup window to customize the display.

Figure 19.  Overlay Setup panel and corresponding plot
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To customize the Multifunction Plot using a Mac OS X Operating System

Follow the steps 1 through 3 above (Windows system); then, click on any of the icons at the top 
of the Select Fill Color popup window to customize Line Color and Fill.

Figure 20.  Select fill color popup window

NOTE: For each test file in the Overlay table, the Fill Column displays the color of the correspond-
ing histogram in the Multifunction Plot.

Formatting and Printing Histogram Plots and Statistics
Scepter Software Pro provides custom reports consisting of tabular data and associated histogram 
plots. This feature is ideal for publishing results of experiments and/or exporting data for further 
analysis. Tabular data is displayed in the Group Stats window and includes results acquired by 
the Scepter device as well as any additional markers applied in the software. For every test file 
included, the Group Stats tables have columns for information and statistical parameters, as 
follows:

■■ Device Name

■■ Sensor Type (40 µm or 60 µm )

■■ Dilution Factor

■■ Original Volume (mL)

■■ Original Concentration (count/mL)

■■ Original Cell Count

NOTE: Dilution Factor, Original Volume, Original Concentration, and Original Cell Count are added 
to the table by clicking the Setup button to access the Group Stats Setup window.

The Overlay Setup, continued



Scepter Software Pro User Guide 17

In addition to the columns listed above, the tables have a set of columns for every histogram 
marker (M1, M2, etc.), as follows:

■■ M1 Low Marker

■■ M1 High Marker

■■ M1 Percent Gated

■■ M1 Mean Cell Diameter

■■ M1 Mean Cell Volume (pL)

■■ M1 Concentration

■■ M1 Cell Count

NOTES: All percent-gated statistics are added to the table by clicking on the Setup button to 
access the Group Stats Setup window.

The listings for the low and high marker boundary positions coincide with the X-axis 
format displayed by the histogram plot (Diameter or Volume).

The Glossary contains explanations of parameters.

To expand the view of the Group Stats window

1.	 Click the Zoom icon to undock the window. Once undocked, the window is semi-
transparent and has a horizontal scroll bar at the bottom.

2.	 Click on the to re-dock the window.

To toggle between the Acquisition and Overlay tables 

Click on the Acquisition or the Overlay button.

The Acquisition table shows stats for the highlighted test file along with all test files that 
are listed in its data node. Stats for test files from other data nodes or Scepter nodes are not 
included in the table. The data includes original stats acquired by the Scepter device as well as 
any additional markers applied after uploading. In contrast, the Overlay table contains only the 
test files and markers used in the Multifunction plot.

To customize fields for a tabular report

1.	 At the bottom of the Group Stats window, click the Setup button. The Group Stats Setup 
window appears.

2.	 Uncheck Show Stats to remove any test run from the table.

3.	 Uncheck any columns to delete from the table. The File Name column cannot be deleted.

4.	 Use the Sample column to annotate test files.

Formatting and Printing Histogram Plots and Statistics, continued
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5.	 Use the Notes/Comments field to summarize the experiment. Summaries are included in 
both the exported CSV file and the printed report.

6.	 When all edits are complete, click Done.

Figure 21.  Group Stats Setup

Dilution Calculator
Scepter Software Pro can be used to automatically calculate original cell culture concentration 
and cell counts based on statistics for diluted samples. The calculation is based on the values 
entered in two columns in the Acquisition table – Dilution Factor and Original Volume. 
Dilution Factor refers to the amount the acquired sample is diluted relative to the starting 
sample. Original Volume refers to the volume, in mL, of the starting sample. The default value 
for both the dilution factor and original volume is 1.00.

To calculate the original concentration and cell count

1.	 Click the Acquisition button on the Group Stats panel to display the Acquisition table.

2.	 Click the Setup button at the base of a Group Stats panel. In the Group Stats Setup 
window, check the boxes above the columns Dilution Factor and Original Volume. The two 
columns are highlighted in blue.

3.	 Double click on the default value (1.0) and enter the correct value. Then, click Done. The 
maximum value that can be entered is 1024.00.

The software recalculates statistics for cell counts and/or the concentration for the total 
events and all marker-defined subsets.

NOTE: Changes to the Dilution Factor affect both concentration and cell count values. Changes 
made to the Original Volume only affect the cell count values.

To customize fields for a tabular report, continued
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Reporting Formats
The stats tables can be exported as independent csv files or directly printed. 

To export as a csv file

Click the Export to CSV button at the bottom of the Group Stats panel. Then, name the file and 
select a location to save it from the directory. The csv file contains the current date, originating 
data folder (or Scepter device), Notes/Comments (if applicable), and the stats table as format-
ted for the selected data set. 

To directly print a stats table

Click the Print Stats button at the bottom of the Group Stats panel. The Printout Preferences 
dialog box appears. The menu facilitates the formatting of the file name and sample ID as well 
as the transposing of rows and columns. After selecting menu options, click Done. The print-
out includes the current date and the entire table as displayed in the Group Stats window. The 
printout for the Overlay table also includes the associated Multifunction Plot and a color-coded 
legend.

Figure 22.  Customizing printouts
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Examples of Comparative Data Analyses
While the Scepter device provides high-quality data through direct reads of cell counts and cell size for 
individual samples, the Scepter Software Pro allows you to use the original data to analyze subpopu-
lations within a single sample and to easily compare data for multiple samples. Following are three 
examples of applications.

Viability/Apoptosis Studies 
A reduction in cell volume is considered a marker of apoptotic progression as well as a key 
driver in the homeostatic signaling cascade ultimately resulting in breakdown of the cell proper. 
Programmed cell death is dependent upon catalytic proteins and cellular mechanisms that require 
active pumping of ions across the plasma membrane; this process contributes to the changes in cell 
volume.

The example below illustrates the downshift in size for apoptosing NIH-3T3 cells following 
exposure to Camptothecin. Healthy NIH-3T3 cells are ~16 µm in diameter; the smaller apoptotic 
fraction is approximately 8.5 µm. The overlay plot (Figure 23) clearly shows an increased fraction 
of smaller-sized cells in the stimulated samples as compared to unstimulated controls. This 
assessment was confirmed by flow cytometry-based fluorescent apoptosis assays performed in 
parallel.

Figure 23.  Overlay of unstimulated cultures
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Figure 24.  Overlay of stimulated cultures

Figure 25.  Overlay of all test files, unstimulated and stimulated

Viability/Apoptosis Studies, continued



Scepter Software Pro User Guide 22

Cell Activation
An increase in cell size is a characteristic of cell activation. Assays measuring T and B cell 
activation are commonly used to identify patterns of immune response in clinical diagnostics 
as well as therapeutic development. In the example below, peripheral blood mononuclear cells 
(PBMCs) were stimulated for varying amounts of time in the presence of phytohaemagglutinin 
(PHA). Cell activation was observed as a gradual upward shift in the overall cell population’s size 
over 18 hours. By 36 hours, dead cells are detected in increasing amounts (histogram marker O2). 
Activation was confirmed by the up-regulation of CD69 expression as measured by flow cytometry.

Figure 26.  Four representative cultures – unstimulated cells and stimulated cells at 6, 18, and 
36 hours
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Figure 27.  Overlay showing overall shift in cell size (marker O2) and the dead cell fraction 
(marker O1)

Co-culturing Experiment
With the advent of in vivo-like culturing systems, cultures involving more than one cell type are 
becoming more frequent. For example, Neuron/Glial cell co-cultures are used to study neuronal 
responses as well as neurodegenerative disease. Also, feeder cell layers are commonly used to 
facilitate the expansion of stem cell lines. 

In the example below, co-cultures of two different-sized suspension cell lines (Jurkat and K562) 
were allowed to propagate in response to various culturing conditions. Data was acquired on the 
Scepter device and analyzed using Scepter Software Pro. The overlays clearly show the difference in 
relative frequency of each cell type in response to differing conditions.

Figure 28.  Comparison of K562 and Jurkat

Cell Activation, continued
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Figure 29.  Overlay of five test files and overlay table

The Help Menu
The Help menu provides a list of resources for maximizing the usefulness of Scepter Software Pro.

About Scepter Application
--the software name, version number, and release date.

Upgrade Scepter Firmware
--menu for upgrading the firmware on your Scepter device.

As a registered user, you will receive e-mail alerts regarding firmware updates and any special 
instructions on the correct steps for completing the updates. Updates should not be attempted 
prior to an e-mail from Millipore.

Scepter Software Pro User Guide
--a PDF of the Scepter Software Pro User Guide

Scepter Device User Guide
--a PDF of the Scepter Automated Cell Counter User Guide

Go to Support Website
--a link to the Technical Service Website, www.millipore.com/techservice. Use this link to obtain 

technical support.

Co-culturing Experiment, continued

http://www.millipore.com/techservice
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Additional Operations
You will receive an e-mail from Millipore notifying you when a new release of the firmware for your 
Scepter device is available.

Updating Device Firmware
To update your Scepter device firmware

1.	 Unplug your Scepter device and other unnecessary USB devices from the computer. 

2.	 Launch the Scepter application.

3.	 Connect the Scepter device to the computer. The Scepter Software Pro connection dialog 
box appears. Select Cancel.

4.	 From the Help menu of the Scepter software, click on Upgrade Scepter Firmware. The 
dialog box Choose firmware file to use appears. Highlight the correct firmware file and 
click on Open.

The Firmware Uploader dialog box appears (Figure 30). The default mode is non-cached. 
The non-cached mode requires a few minutes to complete an upload but is more reliable 
than the cached mode. Checking the box next to Use Cached Mode reduces upload time to 
a few seconds. In either mode, the Firmware Uploader dialog box displays a horizontal bar 
showing the progress of the upload process.

Figure 30.  Firmware Uploader dialog box

5.	 Click on the OK button. A dialog box directs you to cold-boot the device by pressing the 
instrument control button (indexer) on the device for 8 seconds (Figure 31). After the cold-
boot, release the instrument control button and click OK. This action starts the firmware 
installation.
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Figure 31.  Cold-boot dialog box

NOTE: A second after you press the instrument control button, the screen of the device 
goes dark. This is normal. The screen stays dark until the bootloader phase of the 
installation is complete.

6.	 When the installation is complete, a dialog box appears confirming that the firmware 
upload has been successful. Click OK, unplug the Scepter device, and reconnect it after a 
few seconds (Figure 32).

Figure 32.  Successful upload dialog box

Assigning a Name to a Device
Scepter Software Pro is also used to assign names to Scepter devices, to set date and time 
information stored in the devices, and to configure Sensor Settings. All steps are directed through 
features in the Device panel.

The name of a connected device is shown in the text box on the device Device Panel. If the device 
is connected to the application for the first time, it has a default name structured as follows:  
DEVICE-[Serial Number].

Updating Device Firmware, continued
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Figure 33.  Device Panel

To change the name of a connected device
Click in the Name text box and type in a new name. Click Save Changes to complete. The assigned 
name may consist of up to 32 ASCII characters and must include a combination of upper- and 
lower-case letters, numbers, and special characters, such as !@#$%^&*()_+=- .

Setting the Device Date and Time
The device has a real-time clock, which is used to time stamp acquisition of each test file. The 
device must be connected to the application in order to set the date and time values. In the Device 
Panel, the Date/Time textbox displays the current time in real-time according to settings on the 
host computer. The display format is: XX/YY/ZZZZ 00:00:00 conforming to Month/Day/Year and 
Hour:Minute:Second.

To adjust values, click within any component (month, day, and hour); then use the up/down arrows 
at the right of the textbox to adjust the value. The up/down arrow keys on the computer’s keyboard 
can also be used. Click Save Changes to complete.

Changing Sensor Parameters
The Scepter device measures cell count and size based on electrical current, vacuum pressure, 
gain settings, and a Z-correction factor (Z-cor). The values for each of these parameters have been 
optimized for both the 40 µm and 60 µm sensors, across a wide range of cell types. These values 
can be found by accessing the Sensor Settings window from the Device Panel.

Click in any textbox to make changes to a particular setting, then, click Set. To transfer the new 
settings to the device click Save. Completion of the transfer process is password protected. The 
necessary password can be obtained by contacting Millipore Technical Service. Refer to the 
Technical Service section for contact information. Use Restore Default at any time to return to the 
original settings.

Assigning a Name to a Device, continued
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NOTES: Changing any of the sensor parameter values can dramatically alter performance of the 
Scepter device. Millipore strongly recommends maintaining all settings at their Default 
Values.

Changes to settings are not permanent; changes are in effect until the device is powered-
down (sleep mode).

Glossary
Analysis template A set of user-defined regions that may be saved and used to analyze 

multiple test files simultaneously.
Current acquisition plot A histogram used for graphical visualization of a test file that is 

currently highlighted in the Data panel.
Data folder A term referring to a folder where a set of test files is uploaded to 

the computer disc.
Data node A term given to Data Folders and Scepter devices listed in the Data 

panel. Each contains test files.
Marker region An area between a high and low position on the X-axis that delin-

eates a subset of events within a histogram.
Mean cell diameter A sample-wide measurement of particle size reported in microns 

(µm) and determined empirically at the time of acquisition by the 
Scepter device. 

Mean cell volume A sample-wide measurement of particle size reported in picoliters 
(pL) and determined empirically at the time of acquisition by the 
Scepter device.

Multifunction plot A histogram that can be used for the graphical display of a single 
test file or multiple test files in the form of overlays.

Original concentration The amount of particles (cells, beads) in the starting sample report-
ed as count per mL. This statistic is reported in the Group Stats table 
and may be adjusted using the dilution calculator.

Overlay histogram The simultaneous display of data from multiple files in a single 
histogram plot.

Percent gated A statistical measurement based on the number of gated particles 
(e.g., defined by marker M1) as compared to the total particle 
number.

Test file A CSV file imported from the Scepter device.

Changing Sensor Parameters, continued
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Technical Service
For more information, contact the Millipore office nearest you. In the U.S., call 1-800-MILLIPORE 
(1-800-645-5476). Outside the U.S., go to our web site at www.millipore.com/offices for up-to-date 
worldwide contact information. You can also visit the tech service page on our web site at  
www.millipore.com/techservice.

Warranty
The applicable warranty for the products listed in this publication may be found at  
www.millipore.com/ec/cp3/terms (within the “Terms and Conditions of Sale” applicable to your 
purchase transaction).

http://www.millipore.com/offices
http://www.millipore.com/techservice
http://www.millipore.com/ec/cp3/terms
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